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Xilinx ISE Design Suite 11
Welcome

‘We are glad you've chozen Xiline az your platform developrient parther. T his progran will
allows you ta ingtall ISE Design Suite 11 and will conzist of the steps listed to the left.

You will need to have administrator privileges in order to install this software on ‘Windows
operating systems. To reduce installation time, we recommend that you dizable any anti-virus
zoftware before continuing.

‘wie alzo recommend that you install this software to a new directory. If you choose to install
thiz zoftware into an existing 1SE Design Suite 17 directory, you will need to re-install any
updates you may have previously applied. If you choose to install ISE Design Suite 11 into a
directory with an older installation of 1SE, we will require the alder version to be uninstalled
before proceeding.

Hilims 1SE Design Suite 11.1
- /elcome

Accept License Agreements
Select Deshnation Directary
Select Products to [nstall
Select Installation D ptions
Installation

Copyright [] 1995-2003 Xilink, Inc. Al
rights reserved.

L

Mewt » J [ Cancel ]
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ense Agreements

Accept License Agreements (1 of 2}

Pleaze read the following Software Licenze Agreement and click the checkbox below it ta
indicate that you accept the terms of the agreement.

[ LN, INC.
| END UISER: LICENSE AGREEMENT

| CAREFULLY READ THIS END USER LICENSE AGREEMEMT ['AGREEMENT"). BY

| CLICKING THE "ACCEPT" OR "AGREE" BUTTOMN, OR OTHERWISE ACCESSING,

| DOWNLOADING, INSTALLING OR USING THE SOFTWwARE, YOU AGREE ON
BEHALF OF LICENSEE TO BE BOUMD BY THIS AGREEMENT.

Hilin 1SE Design Suite 11.1 | IF LICENSEE DOES NOT AGREE TO ALL OF THE TERMS AND CONDITIONS OF
T | THIS AGREEMENT, DO MOT CLICK. THE “ACCEPT" OR "4GREE" BUTTON OR
! | ACCESS, DOWNLOAD, INSTALL OR USE THE SOFTWARE: AND IF LICENSEE
= Accept License Agreements | HAS ALREADY OBTAINED THE SOFTWARE FROM AN AUTHORIZED SOURCE,
Select Destination Directary FROMPTLY RETURM IT FOR A REFUND.
Select Products to |nstall s
Select Installation Options | 1. Defiritions
Installation | "Authorization Codes” means any FLEXIm license key, licenss fils, license manager,
: dongle or other key, code or information issued by [or on behalf of] Xiling that is
| necessany to download, install, operate and/or regulate User access to the applicable
Copyright [2] 1995-2009 Xiling, Inc. Al | Software.
rights reserved.

I accept the terms of this software license. |

< Back “ Mext » l ’ Cancel




Xilinx ISE Design Suite 11.1

Hilins ISE Design Suite 11.1
Welcome
Accept License Agreements
s Sclect Destination Directary
Select Products to [nstal
Select |nstallation Options
Installation

Copyright [c] 1995-2009 Hiling, [nc. Al
rights reserved.

HILIEX,
i

Select Destination Directory

Select Destination Directory

Select the directory where you want the software ingtalled.

[Ciling 1.1

Select a Program Folder
The name you enter here will appear in the Start Menu->Programs list on your desklop.

[l ISE Design Suite 11

’ < Back ] [ Mext »

) |
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x ISE Design Suite 11.

Hiling ISE Dezign Suite 11.1
Welcome
Accept License Agreements
Select Destination Directory
= Select Products ta Install
Select Installation Options
Inztallation

Copyright [2] 1995-2009 Xiling, Inc. Al
rights reserved.

Select Products to Install

Select Products to Install

Mote: Products not supported on thiz operating system or non-entitled products wil
not be zelectable. For more information on operating system support, please refer
to the Releass Notes.

[0 Product Package List
= @ IsE [esign Suite Product
ISE Design Tools
| Flandhead Analpziz Tool
| DSP Toolz [System Generator, AccellSP)
Embedded Development Kit [EDE)
ChipScope Pro
=20 webPack
ISE webPack
Plandhead &nalpsiz Tool

Digk Space Required : THE3 MB

Dizk Space Available : 10916 MB

Dezcription of |SE Diesign Suite Praduct

Select/Deselect Al

Select which of the prochts_fromThe ISE Design Suite you wish to install, If _l,_lou A'

have purchased an ISE Design Suite Edition, the following list describes which
products are included in each edition.

Logic Edition: ISE Design Tools [Flandhead) and ChipScope Pro
Embedded Edition: 15E Design Tools [Plandhead], ChipScope Pro and Embedded

Development Kit [EDK) |

Y O TR VY S SR S 7 I S VL S ST V-1 1. S T—

< Back ] [ Mext » Cancel

) |




Hiling ISE Dezign Suite 11.1

Welcome

Accept License Agreements

Select Destination Directory

Select Products ta Instal
P Celect Installation Options

Inztallation

Copyright [2] 1995-2009 Xiling, Inc. Al
rights reserved.

XILMX, £
ke e
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Select Installation Options

Select Installation Options
JISE Design Tools

Dresign Environment T ools
| M ‘WebPack Devices
l Foundation/E dition Devices

|DSP Tools (System Generator, AccelDSP)
| Systemn Generator for DSP and AccelDSP Synthesis Tool
l O winPcap 4.0 for Ethemet Hardware Co-Simulation

Dizk Space Required : 7hE3 MB

Select/Deselect Al

Dizk Space Available ; 10909 MB

Dezcription of [SE Design Tool:

[ Installs the ISE D esian Toals (formerly known as ISE Foundation] and Plandhead.
These products include all of the tools needed to design, simulate, implement and
configure your designs in Xiling FPGAs and CPLD s

’ < Back H Mext » Cancel

) |

l

Xilinx ISE Design Suite 11

Hiling ISE Dezign Suite 11.1

Welcome

Accept License Agreements

Select Destination Directory

Select Products ta Instal
P Celect Installation Options

Inztallation

Copyright [2] 1995-2009 Xiling, Inc. Al
rights reserved.

Aapo plosl S pllae |y amio ool wlesdas (6

Select Installation Options

Select Installation Options

Select the environment variables below that you would like the installer to automatically
update with the appropriate values.

If pou deselect any environment variables that are required for the software to work. properly,
you must ensure that you manually set these before using the software,

[ISE Design Tools Al
| B2 SILINGS [Coilingt 11,18 SE]

l PATH [C:4ling’1 1.1 4zommonbbinnt 224 LINSZAbinhnt 2 LINSZ bt ZPATH. .

| ] KILIM_PLANAHEAD [C:AAilinet 1. 14Plandhead]

|PlanAhead Analysis Tool |
! FaTH [#ILING_PLANAHEAD 2M\binZPATH] ‘

|Embedded Development Kit (EDK)
| M HILIME_EDK [C:4ilines11.15EDE]

) T TE R TR TN P o o N SN TR Y I o N TR R T TR

Select/Deselect Al

Description of ISE Design Toolz

”Installs the ISE Design Tools [formerly known az ISE Foundation] and Plandhead.
These products include all of the toolz needed to design, simulate, implement and
configure your designs in #iling FPGAs and CPLD s

< Back ] [ Mext » Cancel

) |
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Xilinx ISE Design Suite 11.1 - Select Installation Options

Hilins 15E Design Suite 11.1

Welcome

Accept Licenze Agreements

Select Destination Directorny

Select Products ta Instal
e Select Installation Options

Inztallation

Copyright [2] 1995-2009 Xiling, Inc. Al
rights reserved.

MILINX, e X
ke e

Select Installation Options

Select the desired installation options below. Selection of these options may result in

additional programs being run at the conclusion of the installation program.

[& Acquire or Manage a License Key
Install Cable Drivers

| O Launch #ilirel pdate

|ISE Design Tools
| Enable webTalk

Select/Deselect Al

Description of Enable 'webT alk

[ Allaws information about what features of ISE and the devices you are using to be
zent ta Xiling. The data sent does not contain any netlist content or proprietary
infarmation.

’ < Back H Newt » ]’

x ISE Design Suite 11.

Hiling ISE Dezign Suite 11.1

Welcome

Accept License Agreements

Select Destination Directory

Select Products ta Instal

Select Installation Options
o |nstallation

Copyright [2] 1995-2009 Xiling, Inc. Al
rights reserved.

XILMX, £
ke e
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Installation

Installation

Options Summary :

| Install Location : C:AXilind11.1

| Program Group : Xilinx ISE Design Suite 11
| Installs the MS Yisual Studio 2005 SP1 Redistribution libraries

| Acquire or Manage a License Key
| Install Cable Drivers

| ISE Design Tools

| Install Location ; C:Milind11.15SE

| RILIN = C:hoxilinst 11,14 SE

| PATH = Tl 17. 1 oommansbinnt 22 LIRSS binsnt 22 LINSZ DS b ZPATHE
| Design Ervironment Toolz

| WiebPack Devices

; Foundation/E dition Devices

' Set Kiling Registry

| PlanAhead Analysis Tool

| Inztall Location : C:hlin11.14Planshead

| #ILINZ_PLANAHEAD = C:ixilinxt11.15\Planéhead
| P& TH = s2ILIN_PLANAHEAD 3\hin PATHE

| Plandhead Commar Files

| Setup Environment

| Embedded Development Kit (EDK)

' Install Location : C:hxilingd11.15EDE

. HILIN_EDK = C:Axilind11.15EDE

| PATH = Z=ILING_EDKZNbin'nt 24 LINA_EDKZNibAntZPATHE
| Platforrn Studio Tool and Processor IP
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* Xilinx ISE Design Suite 11.1 - Installation

Install Cable Drivers
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Xilinx Technology Platforms

Hilins 15E Design Suite 11.1
Welcome
Accept Licenze Agreements
Select Destination Directorny Enable Leading-Edge Applications
Select Products ta Instal

Select Installation Options
o |nstallation

Copyright [2] 1995-2009 Xiling, Inc. Al
rights reserved.

Install Cancel
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[
ailinx ISE 11

oLk License ceai coga 59,1505 cositd cuas l38le 5 LICENSE (g canled 111, Jl8ls 5 )b ool sl ,31(11
Sy |y NEXt aaSs 4 ooges il 1, Get My Purchased License(s) a8 o, cpl ,o 045 o




» ¥ Xilinx License Configuration Manager

Acquire a License f I_\‘!fa!_n?gn_a_Xi_lilji(_Li_;_e_lj_se_s_ |
Select one of the following options

(3 Start Mow! - 30 Day Trial (o Bitstream)
() Start ISE WebPack

() Skart 30 Day Evaluakion

(&) Get My Purchased License(s)

() Locake Existing Licensels)

Description of the above selected option

;Get all purchased licenses and start using your Xilinx software, You will be taken ta the il website where vou can generate and download a
|license file containing keys for all ¥ilinx software and IP yvou have purchased. Once wour license File is generated, the "Manage Xilinx Licenses"
|tab will open to enable wou to configure your system to use the license,

sg=ge XIINX_ISE.NC o5 U ,l5381s 5 DVD s a5 1, sais (5,0 5 LiceNSe L 5 005 1, COpy License a.ss (12
Sy |, Refresh aass g aules bl casl oo

M Xilinx License Configuration Manager
Acquire & License | Manage wilinx Licenses

Instructions: ¥ilinx applications automatically detect valid, node-locked licenses (*.lich residing in the local J¥ilinx directory, Use the Copy License
button to copy a license File into this directory,

Copy License...

To point to a floating server license, or ko point ko license files in locations ather than | ¥ilinx, set one of the environment variables belaw. (Linws:
users will need to make these settings outside of this application.) Examples; 1234@server;Cilicenses) kilin:.lic (wWindows) or
1234@server: fusrflocalFlexim (Linux)

XILINKD_LICENSE_FILE |

LM_LICEMSE_FILE

;Feature Wersion | Expiration  License Count Licenses  Information Server | File
Lirnit Date Type In Use Mame | Mame

, xps_ushZ_device_w2 1.0 Permanent | Modelocked | Uncounted License _Type:Bought Cof L ilinh wilindd,

xps_ushZ_device_wl # Permanent  Modelocked | Uncounted License_Type:Bought Cofoilinwilins,

| P G B N P ™ Rlmdnlnmlind | b d | Sl il i

|
Local System Information
Hostname: awa-519c83aacc
Metwork Interface Card (MIC) ID: 00216bC38132
C: Drive Setial Mumber: 2cesdf3b
FLEXID Dongle ID:

Refresh ] [ Close
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B sk Project Navigator - [What's New in ISE Design Suite 11.1]

b Fil: Edt View Project Sowce Process Tools  Window  Help
e Sl BEX v o (MiALEX R L
Getting Started & X

Y

I +| What's New in Xilinx ISE Design Suite 11
No project is open

This file describes the new features in the Xilinx® ISE® Design Suite 11 software release, It
Select one of the buttons below to get started, e foll :
Alsa, check out the "ihat's New" help page, contains the following sections:
avalable From the "Help” menu, A

= | Note: To disable this page from opening at ISE startup, from the Project Navigator workspace:
Select Edit > Preferences > ISE General menu, and deselect "Open what's New document at

startup.”
Open Example.

Project Brawser. .

» Mew ISE Design Suite Licensing and Product Configurations

o What's New in Logic Design Tools

What's New in Embedded Tools and IP

what's New in DSP Tools and IF

what's New in CORE Generator and [P

Technical Support

New ISE Design Suite Licensing and Product Configurations

The following describes changes in the ISE Design Suite 11:

‘what's New in ISE Design Suite 11,1

Console | Errors | Warnings

Done
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&= ISE Project Navigator

File Edt View Projct Source  Process  Took  Window  Help

DeEd s Exvwe B X 2R

Getting Started 5 x|

No project is open

Select ons of the buttons below to get started, Also, check out the
"what's New" help page, available from the "Help" menu,

< s

Consale Errors " ‘warnings
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25 New Project Wizard g|

Create New Project
Specify project location and type.

Enter a name, locations, and comment. for the project
Mame: LED_bIlnk
Location; D:\WHDL-Projects\LED_blink

Description:

Select the bype of top-level source for the project
Top-level source type:

[HDL

More Info

Mext = H Cancel




Preferred isv jo .0l oly JSeo asle |y o] e i g 7o g95 9 o] 80lgils s FPGA £45 a0l coond ol jo
OS2 8 s ek 1y leudas BU g 0040 ol |, VHDL L5 5.5 Language

25 New Project Wizard

Device Properties
Specify device and project properties,

Select the device and design Flow For the project

Property Name
i Product Category Al
Family |Spartan3

| Dewice
Package
_Speed

| Top-Lewvel Source Type
Synthesis Tool |%5T (VHDL,I'\'\Eng)

| Simulatar

Preferred Language

O

Manual Compile Order

Enable Enhanced Design Summary

Enable Message Filkering

OooE

Display Incremental Messages

Mare Info ’ < Back H Mext = H Cancel ]

SIVHDL 56,51 Ll ssles eoliswl NEW SOUNCE &aS's 5l sns g lol 511, VHDL &l s snlgs o a5 590 50
RUW. V) FRY (5) J.u)|3 OQ; Lﬁ) l) [See) ‘_}J‘ s&.\)‘;) ‘) 0)9]1 L U] Oy 9o, s .‘a.asg Sl S99 9 0l M}J UL'S

25 New Project Wizard

Create New Source
‘fou may optionally create one source at this time, You can add existing sources on the next page, and later create
additional sources with the "Project- =Mew Source” command.

Creake a new source

Source File | [Mew Source...

Remove

Mate Info < Back ” Mexk = H Cancel




I, VHDL Module J56 g5 b a5 045 - ;L New Source Wizard s =, New Source ol o0 5o
Q8B 00l Ol yaue 9 00 bl b 4 aples cds anles Lasie VHDL LB (6l pane g pb SO g 00905 woles]
b Space) alols zs1)ls

2= New Source Wizard @

Select Source Type
Select source type, file name and its location.

IF EL’_ORE enerakor 8 nrcH-itecture Wizar-c.I)-

|[©] schematic

||=] User Document

|[w] verilag Madule

|14 verilog Test Fixture
| '] ¥HOL Module

| YHOL Library ]
f n WHDL Package ;LED_innkI
E YHOL Test Eench
| ¥ Embedded Processor

File: name:

Location:

| D:\WHDL-ProjectslLED_blink

| Add to project

I Mext = ]’ Cancel l

omizmed dwled Las i p S sl Lol Architecture  Entity ¢l oL Define Module ixas ;o
Iy o5 Somiir LED 5 sl aad Jlie ol 50 .awmles o))y LT gz ol ot 0 1, Lol ENLILY o solital 5,50 slocs g
w2 LED @ Jlasil sl 2 1ed ol (2,5 5 g 5950l 4 JLail sl CIK b 4y (539,52 cnlplis el

E New Source Wizard

Define Module
Specify ports for module.

Entity name | LED_blink
Architecture name | Behavioral

Paort Mame Direction | EBus

T | VD
|
S
=N
~iCl
|3
[ ;)
I |3
~I0
|
S0

’ < Back. H Mexk = ” Cancel
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2= New Project Wizard

Create New Source
You may optionally create one source at this time. You can add existing sources on the next page, and later create
additional sources with the "Project->MNew Source” command.

Create a new source

Source File | | Mew Source. ..

1 | LED_blink.whd WHDL Module

[ < Back. H Text = ” Cancel l

Add aass s 059 cnl a1 LT Jlasl suad § ol 09290 L8 51 ;500 £95 b VHDL Ll s> b S a5 55900 50
Ales a8lol o35, a0 1) Jlai 5,50 sl ol 405 1, SOUICE

2= New Project Wizard

Add Existing Sources
Adding existing sources is optional, Additional sources can be added after the project is created using the "Project-
=hdd Source" or "Project-=Add Copy of Source” commands.

Add existing sources

Source File Copy ko Projeck I Add Source
: |

Remove

Mare Info [ < Back. H Text > H Cancel
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Project Summary
Project Mavigator will create a new project with the Following specifications.

roject:
Froject MName: LED blink
Project Path: D:\VHDL-FrojectsiLED hlink
Working Directory:
Description:
Top Lewvel Source Type: HDL

|Device:
Dewvice Family: Spartand
Device: xc3iss0
Package: tcldd
Speed: -5

Synthesiz Tool: ST (VHDL/Verilog)
Simulator: IZ3im (VHDL/Verilog)
Preferred Language: VHDL

Manual Compile Order: false

Enhanced Design Swmnary: enabled
Message Filtering: disabled
Display Incremental Messages: disabled

ew Jource

More Info [ < Back ] I Finish

D9 0ols iules o] Slgizma b asles SIS bls VHDL LG 9, Hierarchy cos jo

ISE Project Navigato WHDL -Projects\ ED_blinkll ED
Edt ‘View Project Source Process  Tools  Window  Help
=4 s X o dhipL XX
Design <08 x i - Revision:

!'J Sources fi -mp\ementahun —- Revision 0.01 - File Created
; T - —- Additional Comwents:

(5] | Herarchy : T

| 5] LED_bink
|2 £3 x(SsﬂSD—StqH‘? i fbrery: TEEE:
[l LED_blink - Behavioral (LED_blink vhd) use TEEE.STD LOGIC 1164.ALL:
use IEEE.STD_LOGIC ARITH.ALL:
use IEEE.STD_LOGIC UNSIGNED.ALL;

- Uncomment the following library declaration if instantiating
- any Xilinx primitives in this code.
—-library THISTH;:
—-use UNISIM.VComponents.all;
<
entity LED blink is
Port [ elk : in 3TD_LOGIC:
led : out STD_LOGIC):
end LED_hlink:

Design Summary /Reports

Design Ltilities

User Constraints

Synthesizs - ¥5T

Implerent Dasign

Generate Programming Fils

Configure Target Device

Update Bitstream with Processor Data
Analyze Design Using Chipscope

architecture Behavioral of LED hlink i=s

begin

end Eehavioral;

Design | Files | Librariss LED_hlink. vhd ‘L Design Summary

Consals

Started : "Launching ISE Text Editor to edit LED _blink.vhd".
Launching Design Summary/Report Viewer...

Consale | Errors | Warnings
Lot Col1 WHOL
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library IEEE:

use IEEE.STD_LOGIC_llSQ.ALL;

use IEEE.3TD LOGIC ARITH.ALL:
use IEEE.ZTD LOGIC UNSIGHED.ALL:

entity LED blink is=
Port ( clk : in 3TD LOGIC:
led : out STD LOGIC):
end LED blink;

W oo -] oo 0ok W

=R e
L I T

architecture Behavioral of LED hlink i=s
begin
process (elk) is
variable count:integer range 0 to 2000000;
begin
if eclk='1' and clk'event then
count :=count+l;
if count<1000000 then
led<='0":
else
ledLsEg i
end if;
end if;
end process;
end Behswioral:

=
()

e Lo &b b o les ol | RUN g 00405 ol ) SIS Synthesize XST &35 4, »» Processes coud o

D9

Processes: LED_blink - Behavioral
Design Surmmary/Reports
Design Ltilities
User Constraints

it =
Implement Design l?t Run
Generate Programming Fils ReRun
Configure Target Device Rerun all
Update Bitstream with Proce; By
Analyze Design Using Chipsc

View Text Report
Force Process Up-to-Date

Design | Files Libraries

Consale Design Goals & Strategies. ..

ETI: Process Properties. ..

e 3 aalgs 1,8 SYNthesize s GT LS 10 ;) o S cedle S5 g ploil w o 4 3w Sllas )31
Adgie Lz 0425 Jdo 4 s Ollas 514055, 0,5 Jlasl cadle b calily ails o jon 4y oo jlaie i Olles
alg COﬂSOlecm_M.é)o Oldas JolS 7 i O jgo 2 50 .0l dled dxlge S5 0,8 llas cudle b il onls

Dwles pladl asl o lallas b baloie a8, a5 Cod ] &) a5 b aglys oo 45 050 o

P synthesize - ¥5T




Lol ENHILY slacs )0 a0 1) 115 5,90 FPGA (sla s asles co (9551 oy ploxl s yokay jiiw Sldoe 45 5,90 50
Floorplan i ;5 g, User CONstraints slaa cgoxe ,; 5 PrOCESSES ool 1o jshite poy anles Jaie
Awled Ol RUN 5 00905 el SUs” Area/I0/Logic (PlanAhead)

Processes; LED_blink - Behavioral

Design Summary/Reports
Design Lilities
User Constraints
Create Timing Constrainks
1/ Pin Planning {Planshead) - Pre-Synthesis
1§ Pin Planning (PlanAhead) - Post-Synth...
: ead)
3 Synthesize - ¥5T
Implement Design ReRun
zenerate Programming File Rerun All
Configure Target Device E

Design | Files | Libraries Wiew Texk Repart

Cansole Faorce Process Up-to-Date
Cpen wWithout Updating

Design Goals & Strategies. ..
Process "Synthesis"™ completed succ {-

o0 Cend 4l Lol ENLILY [0 09290 slac g0 I/O POIS cd )0 043 o I,> PlanAhead lséle 5 )15 ol b
1/0 POrt cod 1o & yem o] am b yo lagdats (oS ST Blo ooty candd lacs 0 51 oS 1o (55, 5T .ol
Deb o0 00l iules Properties

ED_blink - [D:WHDL -ProjectsN_ED_blink\patmplLED_blink.ppr] - PlanAhead 11
File Edit Miew Tools ‘Window Select Layout Help

2 UXAP GOKN$
Physical Hierarchy Og & % Metlist
QX EE =

] floorplan_t
(@) ROOT : 2
[ Primitives (161)

TN NN AW

Properties

G Properties | [} Selection i Metlist | & Constraints il Package @ Device X
10 Porks
Hame: NegDiff Pair | Location | Bank  1)OStd | DriveStrength | Slew Type | Pull Type
2| = Al ports (2)
= Scalar ports (7]
LDk Input LYCMOS25 12 SLOW
L led Cutput LVCMOS25 12 SLOW

13 Console [+ 1/0 Ports

P131 (PADLO) ISE Integration Flow 30M of 4301 i |




, General &5, ;5 1/0 Port Properties cus ,o e a8 SIS bls &9 ondol 9, 1/O POItS s o
Oy 4 098 Jleel ouais b oS SIS APPLY 4aSs (g5, g 0uiS 8,ls 1, FPGA jo i 090 8, Site cond
S o Jeato FPGA 5155 10 a0 1) 5050 <y POO 5Ly Jlio

I/ Port Properties
410
[ k.
Mame: clk
Direction: Ihj:ut'
Site: P55 | [#Fixed

Package Pin:  J3 PSS

Instance: ¥ clk_BUFGF

Net: & ok
EBank: s IfC Bank 4

General | Configure

(2 Properties | [ Selection

9y 9 09905 3l olgzo jela ) o0 Slewlati g oo ,o (o515 8 lilinl 4 by e leddas Wb 5 COnfigure &5, o
LVCMOQOS33 ool Sl 5y o lasbinl ogy s Slaslesl =51 ,0) 00,5 Jlee! lenkass b oss SIS Apply iess
(el 3.3V g 4io 5y mhaw L CMOS o jlaslinl Sl a5 asl

I/ Port Properties
[ clle
If0 Standard:  |LWCMOS33
Drive Strength: |12 {default) s |

Slew Tvpe: |FAST v

Pull Type: NONE.(dEIFaL.ﬂ.t). |

General  Configure

& &pply ] [ [§ Cancel

3 Properties | [} Selection

I/O Parts
Neqg Diff Pair Location Bank I/ 5td Dirive Strength Slew Tvpe Pull Tvpe

Input PS5 4 LYCMOS3T* 12 FAST*
125 ;

clk
- I T I T—

i

[ Consale, O 1/0 Ports




Implement i3 9, Processes cu . ;o .a50,5 5 ISE j158ls 5 4 cons plosil oy Jlasl Slloe a5 (93T

)5 55 Generate Programming File au35 sl 1, )5 ool anles Slxsl |, RUN g 00905 o, Sds” DeSign

Se2g ol « 55,055 et cudle wllos ummo izl lis o) jaw S5 Codle al o yo alwl o s les
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Processes: LED_blink - Behavioral

Create Timing Constrainks
1f Pin Planning (Planahead) - Pre-3ynthesis
1/ Pin Planning {Plan&head) - Post-Synth...
Floarplan &rea/I0fLogic (Planahead)

Synthesize - X3T

Implement Design

FAED Generate Programming File
® @ 3 Configure Target Device
Generate Target PROM{ACE File
e Manage Configuration Project {iMPACT)
Update Bitstream with Processor Data

=>o ,s-b 4 Generate Programming File , Implement Design .Synthesize Ll dea 45 5,0 ;o
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Manage i ;5 g, Configure Target DeviCe icgoxay; 5l Processes cw s ,o ISE I3 sls, 5 5o
50,5 1>l IMPACT l5310 5 b oS Ol 1, RUN 4 08,5 cunl, s Configuration Project (iMPACT)

Processes: LED_blink - Behavioral | beg:f.;
: " i
§ Create Tiring Constraints
1/ Pin Planning {Planshead) - Pre-Synthesis
1/ Pin Planning (Planahead) - Post-Synth...

Floarplan AreafI0fLogic (Planshead)

enc
Configure Target Device end pr
Generate Target PROMJACE File end Behavy
L Manage Configuration Project (i
g d ] 'Ry
E Update Bitstream with Processar Data % ok

ReRun
Rerun Al
Consale I)EH: Stap
Launching : "Generate PROMSACE File™ View Text Report
Force Process Up-to-Date
Open without Updating

Design | Filas ” Libraries_|

Process "Generate PROM/ACE File"™ comp

Design Goals & Strategies...

| il |
7 % Process Properties. ..

Console Errors " Warnings |

obul FPGA 155, bl wb caond cpl 10 g oo pl,55 Sl> PROM Flash G ;0 FPGA sane Sy a5 bxl
Comnd BN |MPACT )|)J|'a)_| BN U"‘)"L"' p...vLo.» JJA.J .mcs A gany L» PROM P‘)f5)" Jab a l) blt & gann L» o0
S s Lls PROM File Formatter a5 ¢, IMPACT Flows

£. ISE iMPACT
File Edit ‘Wiew Operakions ©Qutput  Debug  ‘Window  Help

D2 A|ie [2olew
iMPACT Flows «+0&8 x
- Bal Boundary Scan

Ba Slaveserial
- ma Direck SPT Configuration
SyskemACE

PROM File Formatter

IMPACT Processes

Consale
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Console Errars " Warnings




Eoo dm ag Lol as ol oladas jlal> e aw Jolis o, ool 095 oo ;0 PROM File Formatter s .
wais osliw| PROM Flash s 4y XCFO2S il 5l ez Lo b 10 095 plxil oo j9b 40 il> PROM

1098 3ly S8 Gillae O 50 (o b Slegas
Storage Device Type: Xilinx Flash/PROM
PROM Family: Platform Flash
Device: xcf02s

File Name: ol 35, b lp ol gl
File Location: o155, b !y okl pse
Spled S5 OK 2055 (59, Slonlas 59,5 3y 5l 993 o) (5,300 sk 4 58 Slaciss (3L

£ PROM File Formatter @

Step 1, Select Storage Target Siep 2, Add Storage Device(s) Step 3. Enter Data

Storage Device Type : FROM Farrily [Flatform Flash = aeneral File Detail Value
¥ilinz FlashfPROM Checksuri Fill
= Morviiolatile FPGA Device (bits) [xcfizs  [2M] ~ value &
Spartan3AN 5 t
(= SPI Flash
Configure Single FPGA — —
Configure MuliBoat FPGA | xcfze [zm]
=+ BPI Flash File Location D:WHDL-Projects\LED _blink),
Configure Single FPGA |
Configure MultiBoot FPGA |
Configure from Paralleled PROMs T
Gereric Parallel PROM Flash/PROM File Property

programming_file|

Add Storage Device J [Remnve Storage Device File Marme

File Farmat

| Add Data Files

[ auto select PROM

Description:
In- thi‘; st-epJ o will enl;ér iﬁﬁarmé‘t‘iﬁn tb assi‘sl; .in sett‘\‘ng up anci generating a .PRC.)I‘\;'\. F‘iia I;or.t.hé"target-eci st‘orage cie\.fi.ce ana mo&e.

s Checksum Fill ¥alue: ‘When data is insufficient to fill the entire memory of a PROM, the value specified here is used to caloulate the checksum of the unused portions.
+File Name: This allows you to specify the base name of the file ko which your PROM data will be written
le Location: This allows you to specify the directory in which the file named above will be created
s File Format: PROM files can be generated in any number of industry standard formats, Depending on the PROM file Format wour PROM programmer Uses, you output a TEK, MCS, EXO,
HEX, UFP, ISC or BIN file. MCS is the most popular, IS is used when Eargeting programming Flows that utilize IEEE Skd 1532, Third Party socket-based programmers usually accept any of
the listed formats. If you are using a microprocessor to configure your devices, you oukput a HEX, UFP, or BIM file,
s Add Data Files: Some PROM devices allow you to store user (non-configuration) data For use by the FPGA after configuration, Choose this option if your application needs this capability,

a5 OK 1; Add Device sl

£ Add Device X

Start adding device file to
Data Stream; 0
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Add Device

Look in: | £ LED_blink

I3 _ngo
My Recent [Chipcore_dir
Documents =) en bink_xdh
[Ipatmp
(st

led_blink.bit

My Computer

.

My Network — File name: [lect_blink. bt | Open |
Places
Files of type: |FPG Bit Files [*.bi) ~| Cancel

.5 OK 1, Add Device sl Tsoxs

£. Add Device

‘fou have completed the device File entry.
Click 'Ok’ o contirue
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£. ISE iMPACT - [PROM File Formatter]

'..-@ File Edit Wiew Operations Cutput Debug  Window  Help
U EDRQY BOFAN
IMPACT Flows 08 x|
2% Boundary Scan |5 00000_0000

Ba Slaveserial
‘ma Direck SPT Configuration

[=] SystemacE
|=] PROM File Formatter

: | xcflzZs

el _blink kit

HEY  Wodd
wealys]g

n00s_FRFF

5 PROM File Formatter

Consale

done.
A INFO:iMPACT: 501 - : Added Dewvice xc3sS0 successfully.

bdd one device.de37
<

Console Errors Warnings

PROM File Generation | | Target ¥ilins PROM | | 439,264 Bits used | | File: programming_file in Location: D:\WHDL-Projects\LED_blinkl}

Sgws LPROM Flash o155, L g oas ools il Generate Succeeded plis «ollos oo plol &0 5o
b dalgs sl .MCS

Generate Succeeded

d.)‘_km ‘) )9 (59 TG D Lyusnd .L.:Lo.: JM L.)" O ‘)\]TAG J\)Lfg coyoi )1)5).1 ‘) FPGA Sy9 :UAJU AJLJ ‘_)9,\5‘
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S9y L Smles S Lls Boundary Scan a5 g, IMPACT FlOWS s ;0 IMPACT 13808 5 lae o

Aeles ol 1 Initialize Chain a3 g eoges cusly, SUIS g9, dxio

ISE iMPACT - [Boundary Scan]

\5 File Edt view Operations Cutput Debug  Window Help

D2HDRXD BOER
MPACT Flows
i -:“:].Bouﬁc.iaryScan
B8 Slaveserial = -
‘ma Direck SPT Configuration Add ilin Device... Ctri+D

[=] SystemacE Add Non-¥ilinx Device..,  ChrlHK
|=] PROM File Formatter

+«+ 0 ﬁl.x:

Cable Auko Connect

e | Cable Setup... ime ITAG chain
iMPACT Processes

B e Oukput File Type
fvailable Operations are: |

Boundary Scan

Consale
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Console Errors Warnings

[Ma Cable Connection | | Ma File Gpen




LgLQL..»‘J: Lg‘)_’ |) f‘)jﬁf‘ J_»LS O A*S‘SQ ‘jLMJLAMJ ‘) PROM 3FPGA LgLDM‘fseé; ‘J.i..u‘cb &9}“4 )‘)S‘r:f
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PEEITET - P
IMPACT Flows +0O&F X

- mm Boundary Scan
o BE Slaveserial
- ma Direck SPI Configuration

|2 sstemAcE
|Z] PROM File Formatter

Right click device to select opetations

xcfl2s xc3sa0
bypass bypass

IMPACT Processes
Available Operations are:

£ Auto Assign Configuration Files Query Dialog

Do wou wank to continue and assign configuration Files(s)?

9
-
\‘/ 1 Don't show this message again, save the setking in preference,

[ WEs ] [ Mo

[ le i [ e e g

Console

done.
PROGRESS END End Operation.
Elapzed time = 0 =zec.

< |

Console Errors | Warnings

[Configuration | [Parallel 1| [200kHz | | | [LPTL

Sldee o 50 o plosl cga jo 1) 095, 0,90 wlendas Device Programming Properties a=is o

dled 3)ly pl59

Property Name
Yerify
Erase Befare Programniing
Piead Protect |}
PROMICoolRunner-II Usercode {& Hex Digits) |

Load FPGA |}

| £

o [ ot [ ooy J[ e ]

Jils Program a,;5 55, IMPACT Processes coousd 5l s 03,5 Sl b ass SIS FPGA S g5, 05551
S0, S e Ll ol oo s BB g ooy pl,Sg, FPGA &l al e 0pl )0 048 0 o0ls il SUCCEEdE
Qalgs 5l oo, S g ol ey SL alasls ol cudas wdad g0 40 gd oo 03 RAM dadl> ., , FPGA

24




Ji0 FPGA 4, PROM 1 (suise S ledlbl candas adad 51 o b 090 o159, wub 55 PRPM dlasl> ol s s,

=~ ISE iMPACT - [Boundary Scan]
5 File

Operations  Cukpuk

@ =@
5@ =@

Debug

X
ﬂl:lﬁlx:

Edit  Wiew Window  Help

#i2oen

D |.‘¥ H ; o‘n L-\ll e x
iMPAACT Flows
[ -:“:].Bouﬁc.iaryScan

Ba Slaveserial
‘oa Direck SPT Configuration

[=] SystemacE
|=] PROM File Formatter

xoflze
programming_file....

xc3ss0
led_klink kit

IMPACT Processes

o

e

o Get Device ID

m Gel Device Signature/Usercade
e Check Idcode

o Read Stakus Regisker

=) One Step SWF

=P One Step XSYF

®

Boundary Scan

Consale

_xg INFO:iMPACT — '2': Checking done pin
'Z': Programmed successfully.
PROGREZS_END - End Operation.
Elapsed time = 15 sec.
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Console Errars Warnings

Configuration

Program Succeeded

D9

Parallel TIT | [200KHz | || [LPT1




Jols Program a8 9, IMPACT Processes cuoud jl s 08,5 ol b oS SUS PROM s s,
Program sls, g plosl o yob 4 61,55, Slloe 51055 sl PROM di1 5 6l 555 cllas b oS SIS
Sgd o0 00l iules Succeeded

£ ISE iMPACT - [Boundary Scan]
'-r& File Edit Wiew Operations Cutput Debug  Window  Help
DPFEH ¥ DBXuEnIX: 282
iMPACT Flows w08 x|
+ -':'_i:].Boun.aary Scan

B8 Slaveserial

‘oa Direck SPI Configuration

[=] systemacE
|Z] PROM File Formatter

xcfl2s xc3sa0
programming_file.... led_blink bit

TDO

iMPACT Processes
#vailable Operations are:
m Program

e Yerify

o Erase

e Blank Check

o Readback

e Get Device ID Ll
m Get Device Checksum | '-§ Boundary Scan

Console

'1': Programming completed successfully.
PROGRESS END - End Operation.
Elapzed time = 103 =ec.
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